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Overview

Custom lets you

· configure your NetManage TCP/IP (NEWT) network connections

· connect dial-up interfaces

Note: You can also establish connections through the Dialer as discussed in that application's online 
help.

Many users can configure a connection to the Internet using Automatic Internet rather than 
Custom.    For details, see the online help for the Automatic Internet application.



How to Use Custom

Adding New Interfaces 

Adding New Servers to INETD 

Changing an Interface Name 

Defining a Host Table

Deleting Interfaces 

Disconnecting Interfaces 

Duplicating Interfaces 

Establishing Connections 

Installing Servers Under INETD 

Modifying an Interface 

Modifying Login/Connection Scripts

Setting Passwords 

Setting Up the COM Ports 

Setting Up the Hardware 

Using Custom Terminal



Setting Up the Hardware

To set up the appropriate environment for your computer and network interface adapter, do the following:

1. Complete the preparation form.

2. Choose the Hardware... command from the Setup menu.

The Hardware dialog box appears.

3. Specify information in the Hardware dialog box as discussed in the following table.    Then choose the 
OK button.

Note:    The information you provide is used by the ChameleonNFS product to configure your 
PROTOCOL.INI and CONFIG.SYS files for use with your adapter board.    If you choose to 
have Custom configure your PROTOCOL.INI and CONFIG.SYS files and your ISDN.INI file, 
you can still edit them manually later.

The following information also applies to the ISDN.INI file.

Option Description

Vendor Choose the vendor you are using.

If you are using a network card not listed in our supported vendor list, 
choose Other.

If you want to manually configure PROTOCOL.INI and CONFIG.SYS 
yourself rather than having Custom do it for you, choose None.

Section Name Type the name of the header in the PROTOCOL.INI file used to 
describe your network card.

This name is placed in square brackets in the PROTOCOL.INI file.    To 
determine this information look at the sample PROTOCOL.INI file that 
comes with your network cards NDIS driver.

Driver Name Type the name used by the Drivername= parameter in the 
PROTOCOL.INI file.

To determine this information look at the sample PROTOCOL.INI file 
that comes with your network cards NDIS driver.

Driver File Type the actual name of the NDIS driver file for your network card.    
Entering this information will edit the CONFIG.SYS file to load the 
NDIS driver for your card.

Text box at the 
bottom of the dialog 
box

Enter additional parameters necessary for the PROTOCOL.INI 
network adapter section as required by your specific card.    Consult 
the instructions that accompany your network adapter card for details. 
The information will typically appear under the NDIS or LAN Manager 
sections of the documentation.

Modifying an Interface

Use the following procedure to customize your NEWT TCP/IP configuration.    This method of customizing 
your configuration is required if you are connecting to an Internet Service Provider that has not submitted 
its interface configuration to NetManage.

Note: You can have NetManage automatically configure some Internet connections by using Automatic 
Internet as discussed in that application's online help.



To customize your configuration, do the following:

1. Fill out the preparation form.

2. Select the interface you want to modify and then choose the Configuration... command from the 
Setup menu.

The Configuration dialog box appears.

Note:    You can also open the Configuration dialog box by choosing (double-clicking) the interface 
you want to modify in the Custom window's list box.

3. In the IP Configuration tab, set the IP and dynamic configuration options.

4. Select another tab and configure the options available on that tab.

Note:    You can also move among the tabs by pressing the Ctrl Tab keys.

Which tabs are available in the Configuration dialog box depends on the type of interface you are 
modifying.    For details on a specific tab, choose its name from the following list:

Name Resolution 

Gateway 

Port 

Dial

Call Type

Modem

Login

RAS Configuration 

Advanced

5. Continue selecting tabs until you finish configuring the interface.    Then choose the OK button to 
close the Configuration dialog box.

6. Save your settings by choosing the Save command from the File menu.

7. Choose the Save command from the File menu. 

8. Choose the Exit command from the File menu to close Custom.

Note: Whenever you make changes in Custom, you must save these changes by using the Save 
command from the File menu.    Then you must close Custom and exit all Chameleon applications.



Defining a Host Table

Computers on the network can identify one another through their IP address.    However, you probably 
use names rather than cumbersome IP addresses to identify computers.    The names and IP addresses 
need to be mapped to one another.    You can do this by defining a host table on many computers on the 
network.

To define a host table, do the following:

1. Choose the Host Table... command from the Services menu.

2. Type or select a host name, and choose the Add or Modify button.    After all changes are completed, 
choose the Save button to update the host table file.

A second dialog box appears in which the IP address for the specified name and its aliases can be 
entered.

3. For each alias, type the name and choose the Add button.    Once all changes are completed, choose 
the OK button to return to the Host Table dialog box.

Note: Changes to the host table can be made at any time, even while a Chameleon application is 
running.    Once these changes are saved, every program will have access to these new settings.    
The host table entries appear in all Chameleon applications as a list of selections for a host name 
choice.

You may copy an existing host table file from another Chameleon installation, or from another 
system, such as a Sun workstation.    Place the file in your Chameleon directory under the name 
HOSTS.

As an alternative to a host table on many computers, some networks use a centralized name server to 
maintain name-to-IP address mappings.    For details on configuring your computer in this manner, see 
the Name Resolution tab topic. 



Preparation Form

To complete your installation, you will need some system and network information.    Use the following 
form to help you collect the necessary information before you start the installation process.    Example 
values are shown in brackets.    If you are unsure of any information you need, see your system 
administrator.

General

Where to install software [C:\NETMANAG] ____________________
_

Interface type [Ethernet] ____________________
_

Internet address [156.27.1.51] ____________________
_

Host name [my host} ____________________
_

Subnet mask [255.255.0.0] ____________________
_

For LAN interfaces

Adapter vendor name [3COM] ____________________
_

Adapter type [3C503] ____________________
_

Interrupt level [5] ____________________
_

I/O base address [0x300] ____________________
_

For SLIP/CSLIP/PPP interfaces

COM port [COM2] ____________________
_

Baud rate [9600] ____________________
_

Flow control [Hardware] ____________________
_

Modem type [Hayes] ____________________
_

Telephone number [408-123-1234] ____________________
_

For ISDN interfaces

Vendor [ISDN.TEK] ____________________
_

Board Type [ISDN.TEK1] ____________________
_



IRQ_Level [5] ____________________
_

Memory [0x300] ____________________
_

SPID1 ____________________
_

SPID2 ____________________
_

Optional

Domain Name [netmanage.com] ____________________
_

Default gateway [156.27.1.1] ____________________
_

Domain server address [156.27.1.2] ____________________
_

Modifying Login/Connection Scripts

Login/connection scripts can be included in the configuration of SLIP/CSLIP/PPP interfaces if you would 
like Custom to automatically log in to your dial-up server.    If you prefer to log in to the server manually, 
you can use the Custom Terminal option. 

Some login scripts are provided for you.    If you want to modify the login/connection script, refer to the 
following information. 

· You can modify a login/connection script from the Custom application's Login tab command.

· You can define a different script for each SLIP/CSLIP/PPP interface. 

The login/connection script negotiates the initial login to the remote host. The remote host can be a UNIX 
system, a special SLIP/CSLIP/PPP router like a Telebit NetBlazer, a Chameleon PC, or a terminal server 
that supports the SLIP, CSLIP or PPP protocols. 

A script is a macro statement made up of alternating Expect and Send phrases:

<expect1><send1><expect2>...

· The Expect phrase specifies the characters your computer expects to receive from the remote host 
before it sends a reply.    For example, many scripts begin with the login prompt (such as Login: or 
name:) that is displayed by the remote host when its number is dialed.    For a list of escapes that can 
be used within an Expect phrase, select Expect escapes.

· The Send phrase sends the information that your computer sends in response to a prompt (the 
preceding Expect) from the remote host. For a list of escapes that can be used within a Send phrase, 
select Send escapes.

· Words in the script are separated by either spaces or tabs. 



Send Escapes

A Send phrase sends information from your computer to the remote host.    The information could be 
something that you would otherwise type (such as your username), or it could be information regarding a 
control (such as pausing for a specified number of seconds).

Within a <send> string you can include the following escapes:

Escape Description

$n send a new line

$r send a carriage-return

$s send a space

$b cause a short break on the line

$t send a tab

$1 - $9 pause the indicated number of seconds

$xXX send the character with ASCII Decimal code    XX

$u send the user id

$p send the password

$c send the Startup Command

$d send the phone number

$$ send a $ character

$f define a prompt

$g define an encrypted prompt

$l call-back feature

$- skip a send

Expect Escapes

An Expect phrase is information that your computer expects to receive from the remote host.    The 
information could be a prompt, or a banner. or it could be information regarding a control (such as 
pausing for a specified number of seconds).

Within a <send> string you can include the following escapes:

Escape Description

-- expect "-"

-n skip an expect

-i expect IP address (to replace your own)

Defining a Prompt

Use the $f Send Escape to define a prompt (caption title) that you want to appear on your login message 
box.        Normally, you would want to use $f when using a secure ID and you have to manually respond to 
a security prompt. 

For example, in the following SLIP0 script, the user is prompted to enter his or her password at connect 
time.    This is because the $f<prompt> is defined as Password.

[DEFAULT]
name: $u$r word: $p$r  -n $6$c$r  -i
TYPE=SLIP



[SLIP0}
login:  $u$r word:  $fPassword $r
TYPE=SLIP

When $f is encountered, a dialog box appears with an edit field whose label is the prompt (in this case 
Password).    In this example, the user is prompted to enter his or her password at connect time.



Requesting a Call-Back

If your SLIP or PPP server (that is, the server that you are connecting to) is configured for a call-back 
account, you can use the $l Send Escape to request a call back.    The $l causes Custom to close the 
connection and puts the modem in call-back mode, anticipating a call from the server

Note: Although the following example places the $l prompt at the end of the script, you can place the $l 
prompt anywhere in the script.

[NetCom]
login:  $u$r word:  $p$r   $l



Using Custom Terminal

Use the Custom Terminal feature if you prefer to manually connect and log in to the host (your Internet 
server).    You may wish to use this feature before establishing a script or to test your connection before 
creating a script.

Note: You must configure the Port, Modem, and Dial tab options before using the Custom Terminal 
feature.    However, you do not have to complete the Login settings if you are using Custom 
Terminal.

To connect and log in to your Internet Server using Custom Terminal, do the following:

1. Choose the Configuration... command from the Setup menu.    Then select the Login tab.

2. Select the Ignore Script check box and choose the OK button.

3. Choose the Connect menu option.

The Custom-Terminal log window appears.    You will hear a dial tone and see dialing information 
appear in the Custom Terminal dialog box.

4. In the Custom Terminal log window, enter your login and password at the Login and Password 
prompts.

5. Choose the Set IP button to display the Internet Address dialog box.    Enter your known IP address or 
enter the IP address given by the host in the Custom Terminal window and choose the OK button. 

Note:    The IP button is equivalent to the -i option in Script.

6. In the Custom -Terminal dialog box, choose the Done button when the login process is complete (you 
have entered your username and password, and set the IP Address) . 

If you begin to see an unrecognized series of ASCII characters in the Terminal window, it probably 
indicates that the remote server has finished the login process and begun PPP negotiation.    Or that 
the remote server is sending SLIP data packets. 

7. Choose the Done button to end the login process.

8. When the connection is complete (the Disconnect command replaces the Connect command in the 
Custom menu item), choose the Close button to close the Custom Terminal log window.

Note:    If you choose the Close button whilconnection is taking place, a prompt appears asking if you 
want to disconnect.



Setting Passwords

To set a password, do the following:

1. Choose the Set Password... command from the File menu.

2. Type your password in the New Password box.

If you have already set a password, Custom prompts you for your old password before you set up the 
new password.

3. Type the new password in the Confirm Password field and choose the OK button.

To delete your old password, type your old password and choose the OK button.    You are prompted to 
enter your new password and confirm.



Adding New Interfaces

To add an interface, do the following:

1. Choose the Add...command from the Interface menu.

2. In the Name text box, type the name you want to assign to the interface.

3. From the Type drop-down list box, choose the type of interface you want to add.

4. Choose the Hardware... command from the Setup menu.    Enter the appropriate information in the 
Hardware dialog box.

For LAN interfaces, you need only configure hardware settings if you are using NDIS.    The 
Hardware... command is unavailable for ODI because your adapter should already be configured and 
functioning.

The options available in the Hardware dialog box depend on the type of interface you are configuring.

5. Choose the Configuration... command from the Setup menu.    The Configuration dialog box appears.

6. Enter the IP address and subnet mask bits information.    For details on specifying these options and 
the other IP Configuration options, see the IP Configuration Tab Options.

7. Select the Name Resolution tab and enter an NIS domain name (if you are using NIS), and the host 
resolution order.    For details on specifying these options and the other Name Resolver options, see 
the Name Resolution Tab Options topic.

8. If desired, configure the options on the other tabs.    For details on a specific tab, choose the 
appropriate topic from the following list.    The tabs that are available depend on the type of interface 
you are configuring.

Gateway Tab Options 

Port Tab Options 

Dial Tab Options 

Call Type Tab Options 

Modem Tab Options 

Login Tab Options 

Advanced Tab Options 



Duplicating Interfaces

To duplicate an interface, do the following:

1. Select the interface to be duplicated from the list of configured interfaces.

2. Choose the Duplicate... command from the Interface menu.

The Interface Name dialog box appears.    That dialog box indicates the name that is automatically 
assigned to the new interface.

3. If you want to change the interface name, type the new name in the Name text box.

4. Choose the OK button.

The new interface is added to the list of available interfaces.    Additional information about a specific 
interface can be displayed by choosing that interface from the list.



Deleting Interfaces

To delete an interface, do the following:

1. Select the interface to be deleted from the Custom window's list box.

2. Choose the Delete command from the Interface menu.

3. At the prompt, choose the Yes button.



Changing an Interface Name

If you want to change the name of one of the configured interfaces, do the following:

1. Select the name of the Interface that you want to change from the Custom window's list box.

2. Choose the Interface Name... command from the Interface menu.

3. Type the new name of the interface in the Name text box.

4. Choose the OK button.



Establishing Connections

To establish a connection, do the following:

1. In the Custom window's list box, select the interface you want to connect.

2. Choose the Connect menu option.



Disconnecting Interfaces

To disconnect an interface, do the following:

1. In the Custom window's list box, select the interface you want to disconnect

2. Choose the Disconnect menu option



File

New

Open...

Save

Save As...

Set Password...

Exit



Set Password

Lets you set a password to prevent other users from changing your Custom configuration without 
permission.

See Also
Setting Passwords



Interface

Add...

Duplicate...

Delete

Interface Name...



Add...

Adds the appropriate network interface configuration information for your computer and network interface 
adapter.

The new interface will be added to the list of available interfaces.    Additional information about a specific 
interface can be displayed by selecting that interface.

See Also
Adding New Interfaces



Duplicate...

Duplicates (copies) an existing interface configuration.    You will be asked to identify the new interface by 
a unique name.    This command is very helpful in duplicating SLIP/CSLIP/PPP interface information for 
multiple phone numbers.

See Also
Duplicating Interfaces



Delete

Deletes an existing interface from the list of available interfaces.

See Also
Deleting Interfaces 



Interface Name...

Lets you change an interface's name.

See Also
Changing an Interface Name 



Connect

Establishes a dial-up connection to a remote computer or network.

See Also
Establishing Connections 



Disconnect

Closes the connection between your computer and the remote computer or network.

See Also
Disconnecting Interfaces 



Waiting for call

Indicates your modem is in the Answer mode.    If you choose this menu option, you will reset the modem 
and then be able to establish a connection.



Setup

Hardware... 

Configuration...

Port Setup... 

Log... 



Hardware...

Sets up the appropriate environment for your computer and network interface adapter.

This command is available and necessary only if you have configured an Ethernet, Token Ring, FDDI, or 
ISDN interface (and only if your hardware has not already been configured by other networking software, 
such as Windows for Workgroups).

Note: If you are using ODI drivers, this option will not be available.

See Also
Setting Up the Hardware



Configuration...

Opens the Configuration dialog box which you can use to add or modify interfaces.    The Configuration 
dialog box includes several tabs.    Which tabs are available depend on the type of interface you are 
configuring and whether you open the dialog box in Custom or Dialer.

See Also
Advanced Tab Options 
Call Type Tab Options 
Dial Tab Options 
Gateway Tab Options 
IP Configuration Tab Options 
Login Tab Options 
Modem Tab Options 
Name Resolution Tab Options 
Port Tab Options 
RAS Configuration Tab Options 



Port Setup...

Opens the Port Setup dialog box, which you use to set up the COM ports.    This command is available 
only for ShivaPPP interfaces.

See Also
Setting Up the COM Ports



Setting Up the COM Ports

Before you can establish a dial-in connection for a ShivaPPP interface, you must tell ShivaPPP which 
kind of modem you are using, as well as the COM port to which the modem is attached. You can also tell 
ShivaPPP what speed to use for the connection (in bits per second), how to initialize the modem for the 
best possible connection, and so on.

Note: Changes you make to the Port Setup affect all ShivaPPP dial-in connections, not just the 
connection file that is currently open.

To set up the communication ports for a ShivaPPP interface, do the following

1. Choose the Port Setup... command from the Setup menu.

The Port Setup dialog box appears.

2. From the Modem drop-down list box, select the type of modem you are using.

If the modem you want is not in the Modem drop-down list box, choose the Edit Modem button and 
use the Edit Modem dialog box to add your modem to the list.

3. Select the COM port to which the modem is attached from the Port drop-down list box.

4. Accept the default speed selected in the Speed drop-down list box, or select another speed if desired.

In most cases, you should accept the preset value for the communications speed.    This speed is 
usually the highest speed your modem supports.    However, if you experience a high number of 
communication errors, choosing a lower number on this drop-down list box may eliminate these 
errors.

5. If you want to automatically reconnect if you lose the connection, choose the Reconnect automatically 
when connection is lost check box.

6. Choose the OK button when you finish changing the port settings.

See Also
Advanced Settings Dialog Box



Advanced Settings Dialog Box

Use the Advanced Settings dialog box to specify the Interrupt Request (IRQ) number and Input/Output 
(I/O) address used by your serial port. In addition, you can use this dialog box to specify the command 
ShivaPPP will use to dial a telephone number (such as ATDT or ATDP).

To open the Advanced Settings dialog box, choose the Port Setup... command from the Setup menu.    
Then choose the Advanced button in the Port Setup dialog box.

The following table describes the Advanced Settings dialog box options:

Option Description

IRQ Number If your COM port uses the standard IRQ number, leave this set to Default. If the 
COM port uses a non-standard IRQ number, use the drop-down list box to 
select another value or enter that number here using a value between 2 and 15.

I/O Address If your COM port uses the standard I/O address, leave this entry at Default. If 
the COM port uses a non-standard I/O address, use the drop-down list box to 
select another value or enter that number here.

Dial string In most cases, leave the values in the Dial String Field set to the default setting 
of ATDT. If your telephone connection requires pulse dialing, change the value 
to ATDP.

Enable PPP 
compression

Indicates whether ShivaPPP and the Shiva remote access server should 
compress the information sent over the modem connection. This check box is 
selected by default. If the Shiva remote access server also has data 
compression enabled, selecting this check box can improve the speed of your 
dial-in connection. (If the Shiva remote access server does not have data 
compression enabled or if you are connecting to a non-Shiva remote access 
server, this setting is ignored.)

Note that if you are dialing in to a Shiva remote access server, the remote 
access server must be Version 3.5 or later for compression to be available.

If your COM ports use non-standard values, see IRQ and I/O Settings for COM Ports for more 
information.

See Also
Edit Modem Configuration Dialog Box 
Setting Up the COM Ports 



IRQ and I/O Settings for COM Ports

The following table shows standard settings assigned to IRQ and I/O for COM ports. Most IBM-
compatible personal computers support the settings shown here under Non-MicroChannel PCs. 
ShivaPPP checks for a MicroChannel PC and, if appropriate, uses the settings shown here under 
MicroChannel PCs.

Non-MicroChannel PCs MicroChannel PCs

Serial Port IRQ Number I/O Address IRQ Number I/O Address

COM1 4 03F8 4 03F8

COM2 3 02F8 3 02F8

COM3 4 03E8 3 3220

COM4 3 02E8 3 3228

Edit Modem Configuration Dialog Box

Use the Edit Modem Configuration dialog box to modify an existing modem configuration or create a new 
modem configuration.

To open the Edit Modem dialog box, choose Port Setup from the Setup menu and then choose the Edit 
Modem button.

The following table describes the Edit Modem Configuration dialog box options:

Option Description

Modem Name Type the name of the modem configuration you are currently adding or editing.

Initialize Contains the modem initialization string that is sent to your modem to prepare it 
for a dial-in connection.    See Modem Initialization Requirements for ShivaPPP 
for information on creating or modifying modem initialization strings.

Answer Init Contains the modem initialization string ShivaPPP sends to your modem to 
prepare it to answer the telephone during a dial-back attempt. In most cases, it 
is identical to the Initialize command with "S0=1&W" added to the end.    See 
Modem Initialization Requirements for ShivaPPP for information on creating or 
modifying modem initialization strings.

Speed Choose the maximum speed at which a PC can communicate with the modem 
in bits per second. For most modems, this will be either 38400 BPS or 57600 
BPS.

To change the speed at which your PC communicates with the modem, do not 
change this value; instead, change the value in the Speed field of the Port 
Setup dialog box.

Flow Control Choose the type of flow control the dial-in software uses (Hardware, Software, 
or None). Hardware flow control is also known as RTS/CTS. Software flow 
control is also known as XON/XOFF.

Note that this value tells only the dial-in driver which type of flow control to use; 
it does not tell the modem. You must use the Initialize field in this dialog box to 
determine the flow control the modem will use. The dial-in driver and the 
modem must be configured to use the same type of flow control.

See Also
Advanced Settings Dialog Box



Setting Up the COM Ports 



Modem Initialization Requirements for ShivaPPP

An initialization string to your modem is sent whenever you attempt to dial in to a remote access server.    
This initialization command places the modem in an originating or answering state.

Almost all modems support the basic AT command set developed by Hayes.    Today, advanced settings 
and new modems use many commands which differ from those found on Hayes modems.    Many of 
these settings are default settings on particular modems. This section describes many of the most 
common commands and how they are used in a ShivaPPP modem initialization string.

Note: The values for the commands, and in fact, the actual commands may differ from modem to 
modem. See your modem manual or contact your modem manufacturer for additional help in 
setting the desired features for use with NetManage PPP Dialer.

The information in this section is intended for use in adding a new modem definition in the Edit Modem 
Configuration dialog box.



Log...

Opens the Log window, which records operations done in Custom.    This command is available for serial 
and ISDN interfaces.    It is not available for FDDI, Ethernet, Token Ring, and ShivaPPP interfaces.

To log information, do the following:

1. Choose the Log... command from the Setup menu.

2. If you want to save, print, or copy the contents of the Log window, choose the appropriate button 
(Save, Print or Copy).

3. If you want to delete the contents of the Log window but continue recording messages, choose the 
Clear button.

4. When you no longer want to record messages, choose the Close button.



IP Configuration Tab Options

The following table describes the options available on the IP Configuration tab:

Option Description

IP Address Type your IP address.

For information about illegal, available, and reserved IP addresses, see 
the Internet Addresses topic.

Mask Bits Type the number of subnet mask bits.    Depending on your network, a 
subnet mask may be optional.

The subnet division is used to partition the IP address into a network 
portion and a host portion.

Use Dynamic 
Configuration

Select this check box if you want to configure Chameleon dynamically.

If you select this check box, you will need to choose the BOOTP, DHCP, 
or RARP button.

BOOTP Choose this button if you want your computer to find its configuration 
information by using BOOTP.

DHCP Choose this button if you want your computer to find its configuration 
information by using DHCP.

RARP Choose this button if you want your computer to find its configuration 
information by using RARP.

BOOTP Server IP 
Address

If you chose the BOOTP button and you want to specify a server IP 
address, type that address.

Note: If you do not specify a server IP address, the BOOTP request will 
broadcast on the network.    This is usually preferable.

Reuse Dynamic Data Select this check box to save the dynamic configuration information on 
your computer.

If you store the configuration information obtained from a BOOTP or 
DHCP server, youromputer will have access to that information if the 
server becomes unavailable.

See Also
Name Resolution Tab Options 
Gateway Tab Options 
Port Tab Options 
Dial Tab Options 
Call Type Tab Options 
Modem Tab Options 
Login Tab Options 
RAS Configuration Tab Options 
Advanced Tab Options 



Name Resolution Tab Options

Computers on the network can identify one another through their IP address.    However, you probably 
use names rather than cumbersome IP addresses to identify computers.    The names and IP addresses 
need to be mapped to one another.    You could do this by defining a host table on many computers on the 
network.    As an alternative to a host table on many computers, some networks use a centralized name 
server to maintain name-to-IP address mappings.

The Name Resolution tab lets you

· define which servers your computer can obtain name-to-IP address mapping information

· specify in which order your computer searches for IP addresses

The following table describes the options available on the Name Resolution tab:

Option Description

Host Name Type the network name of your computer.

DNS Domain Name Type the domain in which your computer resides.

NIS Domain Name Type the NIS domain name.

If you do not specify an NIS domain name or enter an invalid name, NIS 
will not be used.

The NIS server is determined by broadcasting to the specified NIS 
domain.    Since multiple servers may be present in a given domain, the 
first server to respond to the broadcast is the NIS server used.

Host Resolution 
Order

Choose the option that specifies the order in which the tables that 
determine the IP address for a given host name are referenced.

Domain Servers Specify which servers maintain name-to-IP address mappings.    You do 
so by typing a server's IP address in the Domain Servers text box and 
then choosing the Add button.

The IP address of a DNS and up to two alternates may be added to the 
list box.

If you add one or more domain servers, a name lookup request is sent to 
the IP address of the DNS.    If the request is not satisfied, the alternates 
are queried in the order specified in the dialog box.

You can delete an IP address from the Domainervers list box by selecting that address and then choosing 
the Delete button.
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Gateway Tab Options

The following table describes the options available on the Gateway tab.    Use this tab to define gateways 
and the route entries for those gateways.    To add items to a list box, specify the appropriate information 
and then choose the Add button.

Note: Configure the options on this tab only if you have multiple interfaces and are using Chameleon as a 
router.

Option Description

Gateway Type the IP address of a default gateway or an alternate gateway. 

Gateways let one subnet talk to any other indirectly connected subnet.

The default and alternate gateways must exist on the same subnet as your 
local PC.    For example, if your IP address is 123.27.1.2, your default gateway 
might be 123.27.1.1. assuming the subnet mask value is the same.

Route Entries

Network Type the network address in the appropriate text boxes.

Note: The network address must be fully specified, up to the host portion of 
the address.    The network address must end with a zero (0).    For 
example, a class B address with eight subnet bits must be specified as 
X.X.X.0 (for example, 137.27.4.0).

Subnet Bits Type the number of subnet bits.

Gateway Type the IP address of the gateway router that should receive packets sent to 
the specified network.

The gateway must be on the locally connected subnet interface.    (For SLIP 
interfaces, specification of a gateway is not needed.)
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Port Tab Options

Note: Changes to port settings other than the baud rate and connector settings should be performed with 
caution.    In particular, hardware flow control is the default setting due to binary communication 
requirements. 

The following table describes the options available on the Port tab.    The Port tab and this help topic can 
be accessed through Dialer, which is an application that lets you establish connections and modify 
interfaces.    If you want to access the Dialer online help, click here.

Option Description

Port Choose the communications port that your modem uses.    If you are using a 
null modem, choose None.

Baud Rate Choose the desired speed of your connection.

Some modems can transmit at more than one baud rate.    The appropriate 
value depends on the baud rate capability of your modem and the baud rate 
supported by your Internet Access Provider.

Data Bits Choose the number of data bits in the data packets sent between your local 
computer and the remote computer.    Generally, you can just use the default.

SLIP/PPP/CSLIP are 8-bit protocols and must have 8 data bits

Stop Bits Choose the number of stop bits between transmitted characters.    Generally, 
you can just use the default.

SLIP/PPP/CSLIP are 8-bit protocols and must have 1 stop bit.

Parity Specify parity as one of the following:

None

Choose this option if you are using SLIP/PPP/CSLIP or you have selected 
8 data bits for the Data Bits option.

Odd

Choose this option to specify that the number of 1s in each data packet 
must always be odd.

Even

Choose this option to specify that the number of 1s in each data packet 
must always be even.

Mark

Choose this option to specify that the parity bit is always on.

Space

Choose this option to specify that the parity bit is always off.

Flow Control Choose the desired flow control method to specify whether the local system 
notifies the remote system when the local buffer becomes too full to receive 
more data from the remote system.

· Choose CTS/RTS if the remote system uses the hardware handshaking 
method of flow control.    CTS/RTS is also known as hardware flow control.

· Choose XON/XOFF if the communications software is to signal whether it 
is ready to receive data.    XON/XOFF is also known as software flow 



control.

· Choose None if the remote system uses no overflow method or if you do 
not know which flow control method is used.

Parity Check Select this check box if you want to show the byte in which an error occurred. 

If you do not select this check box, you will see question marks (?) where the 
modem detected an error.    The question marks will appear at every character 
not transferred correctly.

Carrier Detect Select this check box if your modem supports Carrier Detector and you want to 
use that feature so that the connection script is executed only if Custom 
detects the carrier.

If this check box is cleared (the default), Custom executes the script 
immediately. 

When carrier detect is selected, SLIP uses the carrier detect signal to 
determine whether the modem is on line.    When carrier detect is off, SLIP 
looks at the modem response string to determine if it is connected.    If your 
modem still is not connecting after correctly setting the other options, clear this 
check box and try connecting again.

Hardware 
Reset

Select this check box if you want disconnections done through a Data Terminal 
Readyommand instead of sending +++ and ATH.    This minimizes the 
disconnect time.
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Dial Tab Options

The following table describes the options available on the Dial tab.    The Dial tab and this help topic can 
be accessed through Dialer, which is an application that lets you establish connections and modify 
interfaces.    If you want to access the Dialer online help, click here.

Option Description

Use Prefix Digits If a prefix must precede the telephone number you want to 
dial, select the Use Prefix Digits check box.    Then type the 
prefix in the Use Prefix Digits text box.

A prefix could be another country's access code, an access 
line (such as dialing 9 before you can dial out), or the 1 that 
typically precedes an area code.

Telephone Number Specify the area code and number that is used to establish 
the connection.    You can specify this number by either 
selecting it from the Telephone number list box or typing it in 
the Telephone Number text box.

If you want to indicate Answer mode when connected, leave 
the Telephone Number text box blank.    If you do so and then 
choose the Connect menu option, your software indicates 
you are in the Answer mode.    (In Custom, this indicator is 
the Waiting for call menu option.)

Use Suffix Digits If a suffix must follow the telephone number, select the Use 
Suffix Digits check box and then type the desired suffix in the 
Use Suffix Digits text box.

A suffix is any additional numbers you need to enter before a 
connection can be made.    Typical suffixes are credit card 
numbers, calling card numbers, and the numbers you are 
prompted for by your Internet provider's voice mail.

Hide Suffix Select this check box if you want asterisks (***) rather than 
numbers to appear in the Use Suffix Digits text box.    This 
helps you keep your credit card or calling card numbers 
private.

Dial On Demand Select this check box if you want to automatically connect or 
disconnect your interface through another application (such 
as FTP).

Caution:    You should always check your dial-up 
connections at the end of a session to be sure 
they are closed.    Not all modems operate 
identically and unusual circumstances such as a 
PC being accidentally powered off may not 
guarantee a complete disconnect.

Open Log When Connecting Select this check box if you want to display the log while the 
connection is being made.

Signal When Connected Select this check box if you want to be signaled with a beep 
when a connection is made.

Prompt For Calling Card Number Select this check box if you want a prompt to appear 
reminding you to enter a calling card number while a 



connection is being made. 

Redial After Timing Out Select this check box if you want to automatically redial if 
there is a connection try time out.

Redial After Carrier is Lost Select this check box if you want to automatically redial after 
a connection is lost.

Timeout If Not Connected If you anticipate that the connection may take a long time, 
increase the number of seconds that the terminal waits for a 
connect signal from the remote computer.

For serial interfaces, the minimum value for the timeout if not 
connected is 30 seconds.    For ISDN interfaces, the 
minimum value for the timeout if not connected is 5 seconds.

Manual Choose this button to specify that you want to disconnect the 
interface manually.    You disconnect manually by selecting 
the interface you want to disconnect and then choosing the 
Disconnect menu option.

No Traffic Choose this button if you want the interface to be 
disconnected automatically when the system detects no 
traffic (no packets being sent to or received from your 
system) for a specified amount of time.

If you choose this button, you will need to specify the 
Timeout Before Disconnecting option.

No Open Connections Choose this button if you want the interface connection to 
disconnect automatically when the system detects no open 
connections.

If you choose this button, you will need to specify the 
Timeout Before Disconnecting option.

Timeout Before Disconnecting Type the timeout period in terms of minutes and seconds.

You must specify this option if you select either the No Traffic 
or No Open Connections buttons.
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Call Type Tab Options

The following table describes the options available on the Call Type tab, which is available only for ISDN 
interfaces.    The Call Type tab and this help topic can be accessed through Dialer, which is an application 
that lets you establish connections and modify interfaces.    If you want to access the Dialer online help, 
click here.

Option Description

Data Type Choose the data type of the ISDN call you want to make.

Speed Choose the number of bits per second that is compatible with 
your system.

Note: If you encounter problems using 64K, check that your 
ISDN provider supports this speed end-to-end.    If not, 
use the B 56K option instead.

Hardware board Choose your ISDN board number (typically this number is 1). 
If you are not sure of this number, check with your system 
administrator.

Diagnose Select this check box if you wanto display diagnostic 
information in the log window at the time of connection.

Configure MultiLink Protocol Select this check box if you want to be able to make more 
than one call at the same time with this interface.    You can 
set up your configuration so that each interface can support 
up to two calls.

Use Primary Number for both 
lines

Choose this button if you want to use the same telephone 
number for both calls.

Use different number for 
Secondary line

Choose this button if you want to use different telephone 
numbers for each call.

Primary Number Choose the telephone number you want to use to make the 
first call.

Note: This number will also be used for your second call if 
the Use Primary Number for both lines button is 
chosen.

Secondary Number If you want to use a different phone number for your second 
call, choose the telephone number you want to use when 
making a second call.

Note: This option is only available if you have chosen the 
Use different number for Secondary line button.
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Modem Tab Options

The following table describes the options available on the Modem tab.    The Modem tab and this help 
topic can be accessed through Dialer, which is an application that lets you establish connections and 
modify interfaces.    If you want to access the Dialer online help, click here.

Note: After you select a modem, the remaining options of this tab are automatically filled out with 
information supplied by the modem's vendor.    If you want to change these options, see your 
vendor's documentation.

Option Description

Model Select the appropriate modem type and then choose the Select button.

Modem Selected Indicates which modem is selected.

If you want to add a modem, type a new name in this option.    If you do so, 
you will be prompted to save your changes when you close the 
Configuration dialog box.

Modem Init Type the modem initialization string that you want sent to your modem to 
prepare it for a dial-in connection. 

The ^M character represents a carriage return.

Dial Prefix Type information that prepares the modem for dialing. 

Dial Suffix Type information that signals the modem that dialing is to end.

Binary TX If your modem uses transfer entries to set up the serial port flow control 
through S register 68, set this option to S68.    Otherwise, leave it blank.

Most modems do not use transfer entries to set up serial port flow control. 
For details on whether your modem does, see your modem's 
documentation.

Binary RX If your modem uses receive entries to set up the serial port flow control 
through S register 58, set this option to S58.    Otherwise, leave it blank.

Most modems do not use receive entries to set up serial port flow control.    
For details on whether your modem does, see your modem's 
documentation.

Answer Set Up Type the string that you want sent to your modem to prepare it to answer a 
dial-back attempt.

Hangup Command Type the string that is to tell your modem to hang up.

Max Speed Choose the speed at which your PC is to communicate with your modem. 
The available speeds are in bits per second.
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Login Tab Options

The following table describes the options available on the Login tab.    The Login tab and this help topic 
can be accessed through Dialer, which is an application that lets you establish connections and modify 
interfaces.    If you want to access the Dialer online help, click here.

Option Description

User Name Type the username you enter when logging in.

This field is transmitted when the login script is executed.    The username is 
required for the script to be executed even if there is no need for a 
username.

User Password Type your login password.

This field is transmitted when the login script is executed.

Startup Command Type the command that indicates to the host whether the connection is 
SLIP, CSLIP, or PPP.

This field is transmitted when the login script is executed.

Ignore Script Select this check box if you want Custom to ignore the script that is 
specified in the Script text box.

If you select this check box, you will need to log in through the Custom 
Terminal feature.

Script Type the script that Custom uses to automatically log in to your dial-up 
server.    This script negotiates the initial login to the remote host.    Some 
login scripts are provided for you.

The script is a macro statement made up of alternating Expected Prompt 
during login and Reply string phrases.    For details on replacing or inserting 
script information, see your Installation and User's Guide.

Expected Prompt 
during login

Specify the script phrase that specifies the characters your computer 
expects to receive from the remote host before it sends a reply.

For example, many scripts begin with the login prompt (such as Login: or 
name:) that is displayed by the remote host when its number is dialed.    For 
a list of escapes that can be used within an Expected Prompt during login 
string, see the Expect escapes topic.

You can display Expected Prompt during login string statements by using 
the left arrows (<<) and right arrows (>>) buttons. 

Reply string Specify the script phrase that sends the information that your computer 
transmits in response to a prompt (the preceding Expected Prompt during 
login option) from the remote host.

For a list of escapes that can be used within a Reply string phrase, see the 
Send escapes topic.

You can display Reply string statements by using the left arrows (<<) and 
right arrows (>>) buttons. 
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RAS Configuration Tab Options

The RAS Configuration tab lets you configure the remote access server (RAS) used by ShivaPPP.    The 
following table describes the options available on the RAS Configuration tab.    This tab is available only 
for ShivaPPP interfaces.

Option Description

New Choose this button to reset all connection file information to the default 
values so you can start setting up another connection file.

Open Choose this button to read a ShivaPPP connection file that has been 
saved on your disk.    The information in the file is read and then 
displayed in the ShivaPPP Connect window.

Save Choose this button to save the displayed connection information to disk. 
If you have not yet given the connection file a name, you will be asked 
to provide one.

Save As Choose this button to save the displayed information to disk with a 
different name.    After you choose this button, you are prompted to 
provide a new name for the connection file.

IPX Enabled Select this check box to enable the IPX protocol for your dial-in 
connection, providing access to Novell network services such as file 
servers and print servers.    To use Novell services, you must also have 
Novell client software installed on your PC.

NetBEUI/LLC Enabled Select this check box to enable the NetBEUI and LLC protocols for your 
dial-in connection, providing access to all services on the remote 
network that use those protocols.    You must enable this option to use 
Windows for Workgroups peer-to-peer file sharing and to log on to 
Windows NT servers.

Description Type a description for the connection file.    The description can be    up 
to 64 characters long.

The description is optional.    The value you enter here is displayed 
whenever you make a connection using the current connection file. 
Also, if you use the Make Icon command on the Program Manager's 
File menu, the icon name (by default) will be the description you enter 
here.

Dial-In Name Type the username you were assigned for the remote access server 
you are calling.

Password Type the password for your dial-in name in the Password field if the 
remote system administrator has instructed you to do so.    Otherwise, 
leave the Password field blank.

Note: If you do not enter a password here but your dial-in name 
requires one, ShivaPPP will prompt you for a password when you 
are connecting to the remote network.

Any password you type appears as a row of asterisks (***). For security 
reasons, passwords are not saved when you save the connection file.

Phone # Type the telephone number of the remote access server you want to 
dial.

Type the number exactly as you would dial it manually, using up to 56 



characters (including commas and hyphens).    For example, if you were 
dialing a long-distance call from an office where you have to dial 9 to 
reach an outside line, you might enter 9,1-617-555-1212. Use 
commas if you need to add a pause (usually 2 seconds for each 
comma you use, but this varies with your modem settings). Hyphens (-) 
are optional.

Note: Do not include any modem dialing commands (such as ATDT) in 
this text box.

Keep in mind that many modems cannot handle more than 36 
characters for dialing, so if ShivaPPP reports an error while dialing, this 
may be the cause.

Request Dial-Back Select this check box to enable the roaming dial-back feature of 
ShivaPPP, which lets you tell the remote access server to call your 
modem back at a telephone number that you specify so you can 
reverse the charges for the telephone call.    Not all remote access 
servers support roaming dial-back, and not all users are set up to use 
this feature.

Dial-back Phone # Type the telephone number at which the remote access server should 
call your modem back.    This field is used only if you select the Request 
Dial-Back check box.    The telephone number you enter in this field 
must include any access codes needed to dial your modem's number 
from the remote site (such as 9 to use an outside line, and a 1 for long-
distance calls).

Auto Connect Select this check box to set up this connection automatically whenever 
this connection file is opened.    If you want to make a connection when 
this check box is not selected, you must choose the Connect menu 
option.

Note: If you select this check box, you must make a Program Manager 
icon of the connection file for ShivaPPP to connect automatically.

Lost Carrier Redial Select this check box if you want to automatically redial after a 
connection is lost.

Restore NetWare 
connections

Select this check box to automatically log on to Novell NetWare servers 
as soon as the dial-in connection is established.    This lets you restore 
your permanent server connections automatically each time you dial in 
to a remote access server.

If you do not select this check box, you will have to establish your 
connections to NetWare servers manually after the connection is 
established.

Third-party security 
device installed

Select this check box to use a third-party security device that is set up 
on the remote access server.    If you select this check box, you will 
typically have to enter an additional password after connecting to the 
remote modem but before you have access to the remote access 
server.

If you are not sure whether to select this check box, or you need 
information on what to enter for any third-party security device, contact 
the system administrator for the remote network.

Echo characters locally Select this check box to indicate that the characters you enter for a 



third-party security device should appear on-screen as you type them.    
Select this check box only if you also selected the Third Party security 
device installed check box.

Use script Select this check box if you want to use the script specified in the Login 
tab when establishing your connection.
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Advanced Tab Options

The following table describes the options available on the Advanced tab:

Option Description

IP Address Type the IP address.

Physical Address Type the physical address in the appropriate text boxes.

Caution:    Be careful when setting frequent 
destinations; an incorrect physical address may 
cause network communication conflicts.

Primary Interface If you want the interface to be the primary one, select the 
Primary Interface check box.

Caution:    This setting is automatically set by Custom 
to the correct interface; modifications to this 
setting should be performed with caution.

Ethernet Type If you are using Ethernet, choose the type of Ethernet 
packets your computer can transmit and receive.

Ethernet physical layer packets are one of two forms: DIX or 
IEEE.    The vast majority of networks use DIX, though all 
systems are designed to receive IEEE packets as well.

ChameleonNFS can receive both DIX and IEEE packets 
simultaneously and will send out the format selected in the 
dialog box.    Many other machines will only receive the 
selected format.

Caution:    Unless you are absolutely positive that you 
are on an IEEE packet network, do not change 
this value.    Many systems do not respond 
correctly to IEEE packets, making troubleshooting 
your network very difficult.

Always prompt user when 
changing the primary interface

Select this check box if you want to be prompted each time 
you select an interface.    The prompt will ask you to confirm 
whether you want the selected interface to be the new 
primary interface.    If you do not want the prompt to appear, 
clear this check box.

If you select this check box, Custom displays a dialog box 
that shows you what all the parameter values for the current 
primarynterface are and what they will change to if you 
change the primary interface. 

Make selected interface the 
primary interface

If you select this check box, the protocol stack will check 
whenever data needs to be sent out to see if the data is 
destined for any of the local networks to which the PC is 
attached.    If the packet is not destined for any of the local 
nets, then the packet will be sent to the default gateway of 
the currently selected interface which is also the primary 
interface.    The selected interface is the one that is currently 
highlighted. 
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Services

Host Table... 

INETD Configuration...



Host Table...

Lets you define a host table, which can be used to map computer names and IP addresses with one 
another.

See Also
Defining a Host Table 



INETD Configuration...

Lets you install and add servers for INETD.

See Also
Installing Servers Under INETD
Adding New Servers to INETD



INETD

The Internet Services Daemon (INETD) feature is based upon the UNIX INETD super-server which 
automatically launches other servers when requested.    INETD saves memory and helps eliminate the 
necessity to launch individual servers.

For example, if someone wants to reach you using the Talk application and you do not have it open, but 
have it listed in your INETD configuration, then INETD will open it automatically when it senses that 
someone is trying to reach you through Talk.



Help

Contents

About Custom...



About Custom...

Choose the About Custom... command from the Help menu to display information about the program.    
You can then do either of the following:

· Choose the Copy button to copy the application version information into the Windows clipboard.    You 
can then paste this information into any application.

· Choose the OK button to continue.



BOOTP

The UDP/IP bootstrap protocol (BOOTP) permits a workstation to find its Internet address and other 
configuration information, such as default gateway and domain name server.    A workstation running 
BOOTP client broadcasts onto the network a BOOTP request packet.

A machine running the BOOTP server application returns a response that includes the host's Internet 
address, the address of a boot server, the address of a default gateway, and other configuration 
information such as the addresses of the domain name servers, the subnet mask, and its host and 
domain name.

Note: The BOOTP information returned by the server will supersede your current configuration.

The BOOTPerver must be on the same subnet or else a BOOTP helper is needed on the router.



DHCP

The Dynamic Host Configuration Protocol (DHCP) permits a workstation to find its Internet address and 
other configuration information, such as the default gateway and domain name server.

A machine running the DHCP server application returns a response that may include the host's Internet 
address, the address of a boot server, the address of a default gateway and other configuration 
information such as the addresses of the domain name servers, the subnet mask, and its host and 
domain name.

DHCP is more flexible and returns more information than BOOTP.    It is a dynamic lease, meaning it may 
return different IP addresses depending upon what negotiation has taken place between your workstation 
and the DHCP server.

The DHCP server must be on the same subnet or else a DHCP helper is needed on the router.



RARP

The Reverse Address Resolution Protocol (RARP) permits a workstation to find its IP address.    It returns 
no additional information other than the IP address which is based on a MAC address (Media Access 
Control).    This protocol is useful for users who only have access to a Reverse ARP server.    RARP is 
nots flexible as BOOTP or DHCP.

Note: RARP is not available for serial dialup interfaces.



DNS

Domain Name System.    An online distributed database that maps machine names into IP addresses.



parity

An error-checking procedure that is performed on transmitted data bits.



default gateways

The gateway that is to receive communication destined for addresses in an unknown subnet.



alternate gateways

Gateways that are to be tried automatically if the default gateway fails.



connection file

A connection file contains all of the information ShivaPPP needs to connect to the remote network, 
including the following information:·

· the telephone number of the remote access server you want to dial

· the username and password (if any) you have been assigned for dialing in to the server

· the network protocols (IPX or NetBEUI/LLC) ShivaPPP should use so you have access to the 
networking services you need



route entries

Custom uses the route entries to inform the gateway about the networks that gateway supports for the 
designated interface.    NEWT attempts to route packets designated to destinations other then this host, or 
redirects, by checking the route entries.    If an entry matching the destination is found, the packet will be 
routed to the appropriate gateway through the designated interface.    Packets with an unknown 
destination are dropped.



flow control

A method of managing the flow of data between a DTE and a modem or other DCE. RTS/CTS (also 
called hardware flow control) and XON/XOFF (also called software flow control) are types of flow control.



RTS/CTS

An acronym for Request to Send/Cleared to Send, a method of flow control through an RS-232 cable 
(sometimes called a hardware handshaking cable) in which RTS is the signal sent from the computer or 
terminal to the modem, and CTS is the modem's response indicating that it is ready. RTS/CTS is also 
called hardware flow control. See also XON/XOFF.



XON/XOFF

A software-based type of flow control in which the communications software signals that is ready or not 
ready to receive data. XON/XOFF is also called software flow control. See also RTS/CTS.



Installing Servers Under INETD

To install servers under INETD, do the following:

1. Choose the INETD Configuration... command from the Services menu.    The INETD Configuration 
dialog box appears.

All the servers that INETD can open when requested are listed in the Services list box.    A default list 
of servers that NetManage supplies initially appears.

2. Select the server or servers you want to install and choose the right-arrow button (>>).    All selected 
servers will now appear under the Installed field. 

To remove any installed servers, select the desired server in the Installed field and choose the left-
arrow (<<) button. 

3. Choose the OK button to save changes.

Note: For any changes to take effect, you must restart Windows.

See Also
Adding New Servers to INETD



Adding New Servers to INETD

If you want to add additional servers that are not in the INETD default list, do the following:

1. From the INETD Configuration dialog box, choose the Advanced button.    The Advanced dialog box 
appears.

2. In the Description option, enter the name of the server you want to add.    For example, if you want to 
add a winsock-based Gopher server, you could specify gopher server for this option

3. In the Command line option, type the pathname of the server application you want to add.    Then 
specify the port number in the Port field, and the protocol type in the Protocol field.

4. Choose the Add button to add the server to the list of servers in the INETD Configuration dialog box.

See Also
Installing Servers Under INETD



Troubleshooting

If you experience difficulties using Custom, verify that the installation and setup steps have been 
successfully completed.    For details, refer to the Installation and User's Guide.

 



Setting Up ODI

The Open Data-Link interface (ODI) allows multiple network protocols to be used concurrently on a LAN 
adapter in a workstation on the network and is an alternative to NDIS.    The components of ODI are:

· Network drivers:    Multiple Link Interface Drivers (MLIDs) are device drivers that handle the sending 
and receiving of packets to and from a physical or logical LAN media.

· Link Support Layer (LSL):    Novell's LSL handles the communication between protocol stacks and the 
network drivers (MLIDs)

· Protocol Stacks:    Network Layer protocol stacks transmit and receive data over a logical or physical 
network. 

Custom verifies that your system has LSL.COM running during setup time, and if so, automatically installs 
the version of the stack that supports ODI.    After ODI is installed you can access a Novell Netware 
server, for example, as well as use Chameleon in Windows.

See Also
First Time Installation of ODI and ChameleonNFS
Installing ChameleonNFS in an Existing ODI Environment.
Sample NET.CFG File
Switching from an NDIS Environment to an ODI Environment
Switching from an ODINSUP Environment to an ODI Environment
Troubleshooting ODI



First Time Installation of ODI and ChameleonNFS

To install both ODI and ChameleonNFS for the first time, do the following:

1. At the DOS prompt, create a directory (C:\ODI for example).

2. Copy the LSL.COM, driver (3C503.COM for example).    If you want to use Novell and Chameleon 
concurrently, copy the protocol stack files (IPXODI.COM) and Netware shell (NETX) to this directory.

3. Append the following lines to the end of the AUTOEXEC.BAT file:
C:\ODI\LSL.COM
C:\ODI\<LAN driver> (for example, 3C503)

Optionally, you can add the following lines if you want to have the Novell IPX protocol stack:
C:\ODI\IPXODI.COM
C:\ODI\NETX

4. Create a NET.CFG file and place it in the C:\ODI directory.    Refer to the sample file provided at the 
end of this appendix.

A NET.CFG file is required to run both NetWare and ChameleonNFS concurrently. 

Caution: You need to know which NET.CFG file is used by the ODI environment (LSL).    We suggest 
that you have only one NET.CFG file on your disk.

To ensure smooth establishment of an ODI environment, refer to your network adapter vendor's ODI 
documentation.

5. Reboot your system.

6. If you are using Novell Netware and loaded Novell ODI drivers, then log onto your server using the 
appropriate account and password, and verify to see if you are connected to the server by using the 
WHOAMI command.

7. Start Windows.

8. Install ChameleonNFS (refer to your quick install card).

You can tell when ODI-based ChameleonNFS is installed on your system by viewing the Setup menu 
on the Custom application.    If the Hardware option is dimmed (which is always the case for Windows 
for Workgroups), then ODI is installed on your system and has been detected by the installation 
program.

When you are finished setting up Custom, select the Save option to save your configuration. 

Custom automatically detects the location of the NET.CFG file and then modifies it.

9. If Custom cannot detect the NET.CFG file, a prompt appears asking you to enter its path.    If you 
know the file's location, then enter its path and choose the OK button. 

If you do not know the location of the NET.CFG file, then choose the Cancel button.    Custom will 
automatically copy NetManage's sample NET.CFG file and place it at the root directory of drive C.    
Custom will also open a Window Help file that will give you information about NET.CFG.

Note:    The NET.CFG file that NetManage supplies is only a sample file.    Because user 
environments are configured differently, this sample file may or may not work with your 
configuration.    There is an ODI online help file available that contains detailed information 
about the sample NET.CFG file.    You can choose to view this help file when prompted for it.

10. Reboot your system.

See Also
Installing ChameleonNFS in an Existing ODI Environment.
Sample NET.CFG File



Setting Up ODI 
Switching from an NDIS Environment to an ODI Environment
Switching from an ODINSUP Environment to an ODI Environment
Troubleshooting ODI



Installing ChameleonNFS in an Existing ODI Environment

To install ChameleonNFS for the first time in an existing ODI environment, do the following:

1. Start Windows.

2. Install ChameleonNFS (refer to your quick install card).

You can tell when ODI-based ChameleonNFS is installed on your system by viewing the Setup menu 
on the Custom application.    If the Hardware option is dimmed (which is always the case for Windows 
for Workgroups), then ODI is installed on your system and has been detected by the installation 
program.

When you are finished setting up Custom, select the Save option to save your configuration. 

Custom automatically detects the location of the NET.CFG file and then modifies it.

3. If Custom cannot detect the NET.CFG file, a prompt appears asking you to enter its path.    If you 
know the file's location, then enter its path and choose the OK button. 

If you do not know the location of the NET.CFG file, then choose the Cancel button.    Custom will 
automatically copy NetManage's sample NET.CFG file and place it at the root directory of drive C.    
Custom will also open a Window Help file that will give you information about NET.CFG.

Note:    The NET.CFG file that NetManage supplies is only a sample file.    Because user 
environments are configured differently, this sample file may or may not work with your 
configuration.    There is an ODI online help file available that contains detailed information 
about the sample NET.CFG file.    You can choose to view this help file when prompted for it.

4. Reboot your system.

See Also
First Time Installation of ODI and ChameleonNFS
Sample NET.CFG File
Setting Up ODI 
Switching from an NDIS Environment to an ODI Environment
Switching from an ODINSUP Environment to an ODI Environment
Troubleshooting ODI



Switching from an NDIS Environment to an ODI Environment

If you are switching from an NDIS-based interface to an ODI-based interface, do the following:

1. Start Windows in the Enhanced Mode.

2. Install ChameleonNFS (upgrade installation) according to the instructions on your quick install card.

3. After completing installation, reboot your system and do the following: 

a) Start Windows and then choose the Network icon from the Control Panel.

b) Select NetManage ChameleonNFS (all versions) from the list of networks and choose the 
Remove... button.    The NEWT icon will disappear from your screen.

4. Delete the following from the CONFIG.SYS file:

DEVICE=C:\NETMANAG\PROTMAN.DOS /I:C:\NETMANAG
DEVICE=C:\NETMANAG\ELNKII.DOS (or your card's driver)
DEVICE=C:\NETMANAG\NETMANAG.DOS

5. Delete the following from the AUTOEXEC.BAT file:
\NETMANAG\NETBIND

6. At the DOS prompt, create a directory named C:\ODI.

7. Copy the LSL.COM, Multiple Link Interface Driver (MLID) (3C503.COM for example), protocol stack 
files (IPXODI.COM), and Netware shell (NETX) to this directory.

8. Append the following lines to the end of the AUTOEXEC.BAT file:
\ODI\LSL.COM
\ODI\<LAN driver> (for example, 3C503.COM)

Optionally, you can add the following lines if you want to have the Novell IPX protocol stack:
\ODI\IPXODI.COM
\ODI\NETX

9. Create a NET.CFG file and place it in the C:\ODI directory.    Refer to the sample file provided at the 
end of this chapter.

A NET.CFG file is required to run both NetWare and ChameleonNFS concurrently.

Note:    Make sure you add C:\ODI to your path statement in your AUTOEXEC.BAT file.

To ensure smooth establishment of an ODI environment, refer to your network adapter vendor's ODI 
documentation.

10. Reboot your system.

11. Start Windows from the Program Manager, and select the Run entry from the File menu and enter the 
following:
\NETMANAG\CUSTOM.EXE -o

12. Custom automatically detects the location of the NET.CFG file and then modifies it.

If Custom cannot detect the NET.CFG file a prompt appears asking you to enter its path.    If you know 
the file's location, then enter its path and choose the OK button. 

If you do not know the location of the NET.CFG file, then choose the Cancel button.    Custom will 
automatically copy NetManage's sample NET.CFG file and place it at the root directory of drive C.

The NET.CFG file that NetManage supplies is only a sample file.    Because user environments are 
configured differently, this sample file may or may not work with your configuration.    There is an ODI 
online help file available that contains detailed information about the sample NET.CFG file.    You can 
choose to view this help file when prompted for it.



13. Close Custom, reboot your system, and do the following:

a) Start Windows and choose the Network icon from the Control Panel icon.

b) Choose the Add>> button.    The Dialog box expands to include a list of available networks.

c) Select NetManage ChameleonNFS (all versions) from the list and choose the Install... button.    
This network is added to the list of Installed Networks.

d) Choose the OK button.    The NEWT icon will appear on your screen.

See Also
First Time Installation of ODI and ChameleonNFS
Installing ChameleonNFS in an Existing ODI Environment.
Sample NET.CFG File
Setting Up ODI 
Switching from an ODINSUP Environment to an ODI Environment
Troubleshooting ODI



Switching from an ODINSUP Environment to an ODI Environment

Note: There is no need to keep the ODINSUP configuration with native ODI support.    You may want to 
eliminate some extra layers, thus releasing more memory and increasing reliability.

If you are switching from an ODINSUP-based interface to an ODI-based interface, do the following:

1. Start Windows in the Enhanced Mode.

2. Install ChameleonNFS (upgrade installation) according to the instructions on your quick install card.

3. When the installation is complete, delete the following from the AUTOEXEC.BAT file:
ODINSUP
NETBIND

4. Delete the following from the CONFIG.SYS file:

DEVICE=C:\NETMANAG\PROTMAN.DOS /I:C:\NETMANAG
DEVICE=C:\NETMANAG\NETMANAG.DOS

5. In the Program Manager, choose the Run command from the File menu and enter the following:

\NETMANAG\CUSTOM.EXE -o

6. Reboot your system.

See Also
First Time Installation of ODI and ChameleonNFS
Installing ChameleonNFS in an Existing ODI Environment.
Sample NET.CFG File
Setting Up ODI 
Switching from an NDIS Environment to an ODI Environment
Troubleshooting ODI



Sample NET.CFG File
# # # # # # # # # # # # # # # # # # # # # # # # # # # # 
# net.cfg
# NetManage, Inc. 10/23/95
#
# This net.cfg file is a working example and tested 
# with NetManage TCPIP protocol stack (nmodi/newt) and # Novell IPX protocol stack 
#(ipxodi/netx)simultaneously.
#
# In case a problem occurs:
#
# 1. Make sure there's no other net.cfg on your hard      # disk.
#
# 2. In order for nmodi.com to load/run you need at   # least the following entries in the 
appropriate LINK    # DRIVER section of NET.CFG.
#   Ethernet Adapters:
# frame ethernet_ii
# Protocol IP 800 ETHERNET_II
# Protocol ARP 806 ETHERNET_II
# Protocol RARP 8035 ETHERNET_II
#   TokenRing Adapters:
# Frame TOKEN-RING_SNAP
# Protocol IP 800 TOKEN-RING_SNAP
# Protocol ARP 806 TOKEN-RING_SNAP
# Protocol RARP 8035 TOKEN-RING_SNAP
#
# Please note that all ethernet sections are similar   # as well as all token-ring sections. 
# # # # # # # # # # # # # # # # # # # # # # # # # # # 
# 3COM EtherLink III Adapter
Link Driver 3C509

Frame ETHERNET_802.3
Frame ETHERNET_II
Protocol IPX 0 ETHERNET_802.3
Protocol IPX 8137 ETHERNET_II
Protocol IP 800 ETHERNET_II
Protocol ARP 806 ETHERNET_II
Protocol RARP 8035 ETHERNET_II

# INTEL Ether Express Adapter
Link Driver EXP16ODI

Frame ETHERNET_802.3
Frame ETHERNET_II
Protocol IPX 0 ETHERNET_802.3
Protocol IPX 8137 ETHERNET_II
Protocol IP 800 ETHERNET_II
Protocol ARP 806 ETHERNET_II
Protocol RARP 8035 ETHERNET_II

#IBM Token Ring Adapter
Link Driver TOKEN

Max Frame Size 1552
Frame TOKEN-RING
Frame TOKEN-RING_SNAP
Protocol IPX E0 TOKEN-RING
Protocol IPX 8137 TOKEN-RING_SNAP
Protocol IP 800 TOKEN-RING_SNAP
Protocol ARP 806 TOKEN-RING_SNAP
Protocol RARP 8035 TOKEN-RING_SNAP

#IBM LAN Support Program
Link Driver LANSUP

Max Frame Size 1552
Frame TOKEN-RING



Frame TOKEN-RING_SNAP
Protocol IPX E0 TOKEN-RING
Protocol IPX 8137 TOKEN-RING_SNAP
Protocol IP 800 TOKEN-RING_SNAP
Protocol ARP 806 TOKEN-RING_SNAP
Protocol RARP 8035 TOKEN-RING_SNAP

#OLICOM Tken Ring Adapter
Link Driver OCTOK16

Max Frame Size 1552
Frame TOKEN-RING
Frame TOKEN-RING_SNAP
Protocol IPX E0 TOKEN-RING
Protocol IPX 8137 TOKEN-RING_SNAP
Protocol IP 800 TOKEN-RING_SNAP
Protocol ARP 806 TOKEN-RING_SNAP
Protocol RARP 8035 TOKEN-RING_SNAP

#Madge Token Ring
Link Driver MADGEODI

Max Frame Size 1552
Frame TOKEN-RING
Frame TOKEN-RING_SNAP
Protocol IPX E0 TOKEN-RING
Protocol IPX 8137 TOKEN-RING_SNAP
Protocol IP 800 TOKEN-RING_SNAP
Protocol ARP 806 TOKEN-RING_SNAP
Protocol RARP 8035 TOKEN-RING_SNAP

# eof # # # # # # # # # # # # # # # # # # # # # # # # # # # # #

See Also
First Time Installation of ODI and ChameleonNFS
Installing ChameleonNFS in an Existing ODI Environment.
Setting Up ODI 
Switching from an NDIS Environment to an ODI Environment
Switching from an ODINSUP Environment to an ODI Environment
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Troubleshooting ODI

o Make sure your system is running the latest version LSL and MLID.

Usually manufacturers of network interface cards have the latest version of available MLID.    Or, you 
can download them from Compuserve (GO NOVLIB), or from FTP.NOVELL.COM using FTP. 

o If the NMODI driver fails to load, check the following:

a) Make sure there is no other NET.CFG on your hard disk.

b) In order for nmodi.com to load/run you need the following entries in the appropriate LINK DRIVER 
section of NET.CFG.
Ethernet Adapters:

frame ethernet_ii
Protocol IP 800 ETHERNET_II
Protocol ARP 806 ETHERNET_II
Protocol RARP 8035 ETHERNET_II

TokenRing Adapters:
Frame TOKEN-RING_SNAP
Protocol IP 800 TOKEN-RING_SNAP
Protocol ARP 806 TOKEN-RING_SNAP
Protocol RARP 8035 TOKEN-RING_SNAP

Please note that all Ethernet Link Driver sections are the same as well as all token-ring sections, 
independent of a particular MLID.

If your network media is Token-Ring and you have more than one ring, you may want to put the 
following line in your AUTOEXEC.BAT file before NMODI:
C:\ODI\ROUTE BOARD=2

The board parameter ensures that ROUTE.COM is bound to logical board TOKEN-RING_SNAP, 
which handles TCP/IP traffic.    Refer to the Novell IPX documentation for more information about 
ROUTE.COM

See Also
First Time Installation of ODI and ChameleonNFS
Installing ChameleonNFS in an Existing ODI Environment.
Sample NET.CFG File
Setting Up ODI 
Switching from an NDIS Environment to an ODI Environment
Switching from an ODINSUP Environment to an ODI Environment

 



Network Addresses

The official description of Internet addresses is RFC1020, Internet Numbers.    The DDN Network 
Information Center (NIC) at SRI International in Menlo Park, California, maintains and distributes the RFC 
documents.    The NIC also assigns Internet addresses and network numbers.    When an organization 
applies to the NIC, the NIC assigns a network number or range of addresses that is appropriate to the 
number of host devices on the network.

See Also
Addresses and Routing
Classes of Internal Addresses
Internet Address Conventions
Internet Address Notation
Internet Addresses



Classes of Internet Addresses

As described in RFC1020, Internet addresses are 32 bit quantities, divided into five classes.    Each class 
differs in the number of bits allocated to the network and host portions of the address.    For this 
discussion, consider a network to be a collection of computers(hosts) that have the same network field 
value in their Internet addresses.

The Class A Internet address format allocates the highest eight bits to    the network field and sets the 
highest priority bit to 0 (zero).    The remaining 24 bits form the host field.    Only 128 Class A networks can 
exist, but each Class A network can have almost 17 million hosts.    The following figure illustrates the 
Class A format.

_1_______7_______________________24_______________

|_0_|___Network___|_______________Host_______________|

The Class B Internet address format allocates the highest 16 bits to the network field and sets the two 
highest-order bits to 1,0.    The remaining 16 bits form the host field.    Over 16,000 Class B networks can 
exist, and each Class B network can have up to 65,000 hosts.    The following figure illustrates the Class B 
format.

_1___1__________14_______________16_______________

|_1_|_0_|______Network___|________Host_______________|

The Class C Internet address format allocates the highest 24 bits to the network field and sets the three 
highest-order bits to 1,1,0.    The remaining eight bits form the host field.    Over two million Class C 
networks can exist, and each Class C network can have up to 255 hosts.    The following figure illustrates 
the Class C format.

_1___1__1_____________21________________8________

|_1_|_1_|_0_|__________Network_______|____Host_______|

The Class D Internet address format for multicast groups, as discussed in RFC988.    In Class D 
addresses, the four highest-order bits are set to 1,1,1,0.

The Class E Internet address is reserved for future use.    In Class E addresses, the four highest order bits 
are set to 1,1,1,1.    The router currently ignores Class D and Class E Internet addresses, except for the 
global broadcast address 255.255.255.255.

See Also
Addresses and Routing
Internet Address Conventions
Internet Address Notation
Internet Addresses
Network Addresses 



Internet Address Notation

Internet addresses are written as four 3-digit numbers separated by dots (Periods).    Each number, 
written in decimal, represents an 8-bit octet.    When strung together, the four octets form the 32-bit 
Internet address.    This notation is called dotted decimal.

The following examples show 32-bit values expressed as Internet addresses:

100.100.100.10
255.255.255.255
0.0.0.0
195.32.4.200

The largest possible value offield in dotted-decimal number is 255, which represents an octet of all ones.

See Also
Addresses and Routing
Classes of Internal Addresses
Internet Address Conventions
Internet Addresses
Network Addresses



Internet Addresses

Some IP addresses are reserved for special uses and should be used for host, subnet, or network 
addresses.    The following table indicates which IP addresses are available and which ones are reserved. 
Avoid illegal addresses such as broadcast (0.0.0.0), subnet broadcast (156.27.0.0 or 156.27.255.255), or 
loopback (127.x.x.x). 

Class Address or Range Status

A 0.0.0.0

1.0.0.0 through 126.0.0.0

127.0.0.0            Loopback

Reserved

Available

Reserved

B 128.0.0.0

128.1.0.0 through 191.254.0.0

191.255.0.0

Reserved

Available

Reserved

C 192.0.0.0

192.0.1.0 through 223.255.254

223.255.255.0

Reserved

Available

Reserved

D, E 224.0.0.0 through 
255.255.255.254

255.255.255.255

Reserved

Broadcast

See Also
Addresses and Routing 
Classes of Internet Addresses 
Internet Address Conventions 
Internet Address Notation 
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Network Addresses 



Internet Address Conventions

If the bits in the host portion of an address are all 0, that address refers to the network specified in the 
network portion of the address.    For example, the Class C address 192.31.7.0 refers to a particular 
network.

Conversely, if the bits in the network portion of an address are all 0, that address refers to the host 
specified in the host portion of the address.    For example, the Class B address 128.1.255.255 refers to 
all hosts on the 128.1.0.0 network.    (Remember that an octet of zeros becomes the decimal number 
255.)

Because of these conventions, do not use an IPddress with all zeros or all ones in the host portion for 
your router address.

See Also
Addresses and Routing
Classes of Internal Addresses
Internet Address Notation
Internet Addresses
Network Addresses 



Addresses and Routing

Consider a host sending an Internet data packet.    If the destination host and sending host are on the 
same network, the packet goes directly to the destination host.    If the destination host and sending host 
are on different networks, the packet goes to a router.    Addresses make this routing and delivery of data 
packets possible.

To determine whether the destination host is on the same network, the sending host compares the 
network portions of the destination address and its own address.    If these network numbers are the 
same, the destination host is on the same network.    If the network numbers are different, the destination 
host is on another network, and the data packet must go to a router.

A router has two or more network interfaces onto different networks.    The primary function of the router is 
to direct packets between these networks, delivering them to their final destination or to another router. (A 
router-to-router transmission is called a hop.)

To begin the routing process, the router examines the network number of the destination address.    Using 
this number as a key, the router locates applicable routing information in its routing table.    The router 
uses this routing information to send the packet to its final or to an intermediate destination.

See Also
Classes of Internal Addresses
Internet Address Conventions
Internet Address Notation
Internet Addresses
Network Addresses 



Subnetting 

Subnetting is a scheme for imposing a simple hierarchy on hosts on a single physical network.    The 
usual practice is to use the first few bits in the host portion of the network addresses for a subnet field.    
For example, the following figure shows a Class B address with five bits of the host portion used as a 
subnet field.    The official description of subnetting is RFC950, Internet Standard Subnetting Procedure.

_1___1__________14________5__________11_________

|_1_|_0_|______Network___|_Subnet_|____Host__________

As with theost portion of an address, do not use all zeros or all ones in the subnet field.

See Also
Subnet Masks 
Subnetting and Routing



Subnetting and Routing

Routers and hosts can use the subnet field for routing.    The rules for routing on subnets are identical to 
the rules for routing on networks.    However, correct routing requires all subnets of a network to be 
physically contiguous.    In other words, the network must be set up so that it does not require traffic 
between any two subnets to cross another network.    Also, RFC950 implicitly requireshat all subnets of a 
network have the same number of bits in the subnet field.

See Also
Subnet Masks 
Subnetting 



Subnet Masks

A subnet mask identifies the subnet field of a network address.    This mask is a 32-bit Internet address 
written in dotted-decimal notation with all ones in the network and subnet portions of the address.    For 
the example in the following figure, the subnet mask is 255.255.248.0

_1___1__________14________5__________11_________

|_1_|_0_|______Network___|_Subnet_|____Host__________

The following table shows the subnet masks you can use to divide an octet into subnet and host fields.    
The subnet field can consist of any number of the host field bits; you do not need to use multiples of eight. 
However, you should use three or more bits for the subnet field-a subnet field of two bits yields only four 
subnets,two of which are reserved(the 1,1 and 0,0 values).

Subnet Masks

Subnet Bits Host Bits Hex Mask Decimal Mask

0 8 0 0

1 7 0x80 28

2 6 0xC0 192

3 5 0xE0 224

4 4 0xF0 240

5 3 0xF8 248

6 2 0xFC 252

7 1 0xFE 254

8 0 0xFF 255

See Also
Subnetting 
Subnetting and Routing

 



New

Choose the New command from the File menu to open a new configuration file.

The settings specified in the configuration file will be loaded when the application is started.    The file has 
a .CFG extension.



Open...

Opens an existing configuration file for the application.    The settings specified in this file will be loaded 
when the application is started.    The file has a .CFG extension.

To open an existing configuration file, do the following:

1. Choose the Open command from the File menu.

2. Select the file you want to open.

If necessary, locate the desired file by selecting the appropriate drive and directory.

3. Choose the OK button.



Save

Choose the Save command from the File menu to save the application's current configuration file. 



Save As...

Choose the Save As... command from the File menu to save settings for the application to a different 
configuration file.



Exit

Choose the Exit command from the File menu to exit the application.



Contents

Choose the Contents command from the Help menu to display the contents of the application's Help 
system.

While using Help, you can return to the Contents screen by choosing the Contents button in the Help 
window.



About...

Choose the About... command from the Help menu to display information about the program.    You can 
then do either of the following:

· Choose the Copy button to copy the application version information into the Windows clipboard.    You 
can then paste this information into any application.

· Choose the OK button to continue.



Fonts ...

Lets you set the

· font type style ( including bold and italic )

· size and width of the message body in the application's main window

To select a font, do the following:

1. Choose the Fonts... command from the Settings menu.

2. Select the font, font type, and font size you want to use.

3. Choose the Apply button to apply your selections    Then choose the OK button.



Toolbar

Choose the Toolbar command from the Settings menu to display or hide the application's toolbar.    The 
toolbar gives you quick mouse access to some of the application's functions.



Smart Buttons 

Choose the Smart Buttons command from the Settings menu to display toolbar icons, including each 
icon's description.



Status Bar

Choose the Status Bar command from the Settings menu to display or hide the application's status bar.

The application displays messages and statistical information in the status bar, which is located at the 
bottom of the application's window.

 




